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The MLA150 is a high speed direct write lithography tool extended by capabilities 

formerly only available on Mask Aligners. It can expose the patterns directly without 

prior fabrication of a mask resulting in a significantly shorter prototyping cycle. It offers 

topside alignment and backside alignment with high accuracy, and a light source which 

generates sufficient dose to expose even thick and less sensitive resists. The MLA150 

allows using substrates of any size and shape and provides flexible change of pattern, 

distortion compensation and other software corrections. The system can produce 

structures down to 1 µm. The alignment accuracy can be as good as 250 nm under 

optimized conditions. 

1.1 About this user guide 

This user guide gives information and instructions on how to handle the MLA150 system 

properly. It is important that every person who intends to work with the system reads 

this guide in order to avoid possible mishandling leading to damage to the system or to 

persons. Therefore, by all means, read the safety instructions carefully before starting 

work with the system. The guide assists the user in performing the exposure procedure 

beginning at system startup and ending with the exposure procedure itself. The 

subchapters in 6 Job Setup build a sequence of tasks that have to be executed in order 

to prepare the exposure job.  

Additionally, you find a description of the system and of the Exposure Wizard. Also, 

information about system utilities and troubleshooting are given in the final chapters.  

Technical data can be found in the related document Technical Data Sheet 

To facilitate following the instructions and information, a list of conventions indicating the 

type of information is given here.  

 

  

Note: Indicates that additional information or advice follow to get best results.  

1. Signalizes that this is the first step of a step-by-step instruction followed by 
further steps 

  Indicates a result which the user can see or hear. It can also just be an 
intermediate result and can therefore be followed by further steps of the same 
instruction.  

 

Indicates that the following information or instruction is an alternative step e. g., 
to abort a process or to be referred to another instruction or chapter. 

ii i 
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1.2 Contact 

Should you need assistance, please contact your local service office:  

You can also reach Heidelberg Instruments via email: himt@himt.de, or visit our site on 

the internet: http://www.himt.de  

 

China:  Europe: 

Heidelberg Instruments Service China 
Rm.101, Block 1, Animation Park, 
Yuehai Street, Nanhai Road, 
Nanshan Distr., Shenzhen 518045 
China 
Phone:+86-755-8301599-1 / -2 / -7 
Fax: +86-755-8301599-4 
Email: service_china@himt.de 

 
Heidelberg Instruments GmbH 
Service Department 
Tullastraße 2 
69126 Heidelberg 
Germany 
Phone: +49-6221-3430-0 
Fax: +49-6221-3430-30 
Email: service_europa@himt.de 

   

Japan:  Korea: 

Heidelberg Instruments Service Japan 
Germany Center for Industry & Trade 
1-18-2, Hakusan 
Midori-ku, Yokohama, 226-0006 
Japan 
Phone:+81-45-938-5250 
Fax:  +81-45-938-5251 
Email: service_japan@himt.de 

 
Heidelberg Instruments Service Korea 
#316 Expo Officetel, 381 
Mannyeon-dong, Seo-gu 
Deajeon, 35203 
South Korea 
Phone:+82-42-482-1668 
Fax: +82-42-482-1669 
Email: service_korea@himt.de 

   

Taiwan:  USA: 

Heidelberg Instruments Service Taiwan 
6F-5, No. 192 DongGuang Road 
Hsinchu City, 30069 
Taiwan 
Phone +886-3-5715188 
Fax +886-3-5715388 
E-Mail: service_taiwan@himt.de 

 
Heidelberg Instruments Inc. USA 
2807 Oregon Court, Unit E2 
Torrance, CA, 90503 
USA 
Phone:+1-310-212-5071 
Fax: +1-310-212-5254 
Email: service_usa@himt.de 

 

http://www.himt.de/
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1.3 Related documentation 

Heidelberg Instruments offers several further manuals related to the machine and its 

operation. If you did not get one of these or need an update, please contact Heidelberg 

Instruments, Germany (1.2 Contact). See the list of related documents below:  

  

• Pre-Installation Guide Environmental and electrical 
requirements, sizes and weights of 
components etc. 
 

• PI- Site Inspection checklist Checklist containing questions regarding 
the conditions of the costumer’s 
installation site for the system.  
 

• Safety guide Describes necessary safety measures 
during move-in, installation as well as 
servicing and maintenance times. 
 

• Conversion Software Manual Manual for the HIMT conversion software 
used for data preparation and fractioning. 
 

• Design Guide Instructions on design rules and design 
creation. 
 

• Maintenance Guide Guide for Maintenance and 
Troubleshooting, as well as an overview of 
typical service tasks. 

• Technical Data Sheet Overview of the systems technical data. 

• Quick Guide Short instructions to execute an exposure. 
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The MLA150 protects operators from exposure to laser radiation, dangerous voltages or 

moving parts while operating the equipment. All moving parts, lasers and their 

associated optics are enclosed within a flow box. During operation, opening the flow box 

window will immediately stop any exposure or measurement process. 

Still, it is vital that the operators and all other persons who are allowed access to the 

system have been informed about any remaining risks. 

2.1 Intended use and limitations 

The intended use of the MLA150 lithography system is to expose structures on 

photosensitive, non-flammable layers which are located on non-flammable substrates. 

These substrates must not exceed the specified maximum dimensions and must be free 

of damage such as scratches or cracks.  

The MLA150 is intended only for professional use. The related user documentation is 

part of the product, and the user is under the obligation to read the documentation 

before using the product.  

Every other purpose of use than that stated in this section is prohibited. In case of 

damage by using the product outside this stated purpose, no liability is assumed by the 

Heidelberg Instruments Mikrotechnik GmbH.  

In addition to the intended use stated above, the following purposes of use are 

prohibited and defined as misuse: 

Operation outside the operating data stated in the data sheet or in the sales 

confirmation.  

Operation with materials other than the approved materials. 

Change of the factory settings by unauthorized persons. 

Use of attachment parts other than Heidelberg Instruments components. 

Operation of the system in a potentially explosive environment or aggressive 

atmosphere. 

No untrained person, or person not familiar with the contents of the following sections 

is allowed to operate the system or work in its close environment. If instructions are not 

followed carefully, danger to personal health and damage to the equipment is at risk. 

At all times, follow all warnings and instructions given in this manual, the system 

software, safety labels on the system, or by our engineers. 
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2.2 Conventions 

Throughout this manual there are safety warnings. To classify the degree of danger in 

each of these situations, this guide uses the conventions defined in ANSI Z535.6-2011: 

 

       
Laser 
beam 
hazard 

Electrical 
shock 
hazard 

General 
warning  

Toxic 
hazard 

Corrosive 
material 
hazard 

Flammable 
material 
hazard 

Pinch 
point 
hazard 

2.3 Laser safety 

The MLA150 employs two types of continuous wave lasers, one for position 

measurement of the stage (interferometer laser), and one for design exposure 

(exposure laser). When the window is closed, all laser light is blocked or absorbed, and 

the system is effectively of laser class 1. 

When the window is opened for loading or unloading, the interferometer laser beam is 

accessible. Under this condition, the system has the same laser class as the 

interferometer laser in use, which is laser class 2. 

Laser Type Wavelength (nm) Power (mW) Laser Class 

HeNe 632 < 0.6 2 

The exposure laser beam is a powerful beam that is usually covered completely by 

optics covers. Power and wavelength of the exposure laser depend on the specific 

configuration, but the exposure laser beam is always dangerous for the eye, sometimes 

also for the skin. Even reflected light may be dangerous. 

If the optics covers are opened, the accessible energy is of the class 4 category 

(DIN EN-60825-1).  

 
Danger indicates a hazardous situation, which, if not avoided, will 
result in death or serious injury. 

 
Warning indicates a hazardous situation, which, if not avoided, 
could result in death or serious injury. 

 
Caution indicates a hazardous situation, which, if not avoided, 
may result in minor or moderate injury. 

 
Denotes warnings against possible misuse that can lead to 
machine damage. 

Laser Type Wavelength (nm) Power (mW) Laser Class 

Diode, blue 405 ≤ 8000 4 

Diode, UV 375 ≤ 3000 4 
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If conditions require the opening of the optics covers, such as for servicing or 

troubleshooting by trained service personnel, then personnel must observe all 

precautions required for a laser of above mentioned class in the whole area surrounding 

the MLA150. 

 

 

Eye injuries and/or skin burns! 

Severe damage to the eye and possibly to the skin can be 
caused by laser radiation of class 3B or 4 

• Avoid possible direct or indirect exposure of eyes or skin to 
laser radiation at all times. 

• Do not operate the system with open optics cover if not acting 
under explicit instruction of an HIMT service engineer. 

• Do not enter any area cordoned off by HIMT service 
engineers during adjustment work. 

• Do not put anything reflective or flammable into the beam 
path. 

 
If the system has to be operated with open optics cover e.g., for 
trouble shooting: 

 

 • Cordon off the area and place warning signs. 

• Wear appropriate safety goggles. Note that these cannot 
protect long against a direct beam but are only meant as 
protection against stray light! Also keep in mind that you 
cannot see the laser beam with goggles on, so the risk of skin 
burns increases. 

• Use the lowest possible laser power or reduce the power as 
far as possible with filters. 

• Never leave the laser on when unattended. Make sure only 
qualified personnel may switch on the laser in such a 
machine state. 

• Do not place reflective objects in, or near the laser beam path. 
Laser light scattered by reflective objects can be as damaging 
as the original beam. Objects such as rings, watchbands, 
and metal pens or pencils can be hazardous. 
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2.4 Electrical safety 

A CEE type 220-240 V, 16 A single-phase cable connector supplies operating power in 

the MLA. It is also possible to attach a local-type cable to a local-type wall connector. 

Please refer to the Pre-Installation Guide for details. 

 

 

Electrical Shock! 

Fatal electrical shock and/or severe burns can be caused by the 
supply voltage of up to 240VAC 16A for the system, and up to 
420VAC 32A for certain laser types. 

• Never use the equipment if cables or plugs have been 
damaged. 

• Plug the MLA and its components only into approved outlets 
with correct ground. Power requirements are described in the 
Pre-Installation Guide. 

• Ensure that both the voltage and frequency of a power source 
match the voltage and frequency stated on the equipment’s 
electrical label. 

• Not all power cords have the same current ratings. 
Household extension cords do not have overload protection 
and are not meant for use with sensitive electronic 
equipment. Never use household extension cords for any 
component of the MLA. 

• Always follow the five safety steps if equipment containing 
electrical circuits with voltages >50VAC has to be opened: 
disconnect, apply restart lockout, check if equipment is de-
energized, ground / short circuit equipment, cover 
neighboring elements that are still energized 

• If access to the interior of any electronics component is 
necessary while system is in operation, exercise extreme 
caution. Only qualified service personnel may have access to 
the interior. 
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2.5 Other risks during operation 

 

 

Injuries by moving parts or heat! 

If covers are removed, the operator may be exposed to 
dangerous collisions with moving parts, or heated components. 

• Do not remove any covers that are fixed with screws 

• Heed the warnings if removing any other covers 

 

 

 

Pinch risk by closing window! 

Mild pinch injuries are possible if fingers are brought between 
the upper window frame and the window while the window 
closes. The loading window is driven pneumatically with low 
pressure. It does not have enough force to injure a body or 
limb, but skin may be pinched. 

• Do not close the window while resting a hand at the upper 
frame or upper window edge. 

• Do not put a hand through the already closing window. 
 

2.6 Interlock 

To protect the operator from hazards by laser light or moving stage, interlock circuits 

prevent stage movement and access to laser light as soon as the window opens. A 

safety switch stops the stage, holding it in position, and closes the laser shutter. If an 

exposure has been running at that moment, the result is irreversibly lost. 

The stage interlock can be overridden by service engineers by a key switch for 

servicing, together with a confirmation from the menu. While this service mode is 

activated, the main bar and background of the Exposure Wizard turns red.  

 

 

Injuries by moving parts or laser light! 

While the system is in service mode, dangerous levels of laser 
light are accessible, and the stage can move with window open. 
Only HIMT service engineers are allowed to put the machine into 
service mode. 

• During servicing or maintenance by service engineers, heed 
the warnings given in the Safety Guide. 

• If service mode was left active accidentally, switch back to safe 
mode and remove the key. Return it to the service local office. 
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2.7 Labels 

Flowbox front 

 

 

 

 

 

 

 

 

 

Electronics Rack 

 

 

 

 

 

 

 

 

 

  FRONT DOOR  REAR DOOR  
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Optics cover:  

front cover, side covers, rear cover 

 

  

Functioning of medical implants may be 

disturbed, and objects may be attracted. 

Wearers of pacemakers must keep a 

distance of at least 300 mm/12”. Be 

careful when using tools close to the 

magnets. 
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This chapter gives a short description of the MLA150 lithography system. The MLA150 

system consists of the following individual components: 

▪ Lithography Unit  

▪ Electronics Rack 

▪ Cooling water supply (not explicitly described in this document) 

▪ Operator workstation 

 

The main principle of the functional interaction between the system components is as 

follows: 

A workstation comprising two computer monitors, a keyboard, a mouse and the User 

PC, that is located inside the electronics rack, represents the interface between user 

and system. The user controls the system via our graphical user interface on the User 

PC. This data is processed by the components located inside the electronics rack such 

as the stage controller which communicates with the stage and controls its movement 

based on the feedback given by interferometers that are placed in the main unit.  

The system has two cooling water supply units, called chillers. One of them makes sure 

that the system runs in a stable environment in terms of temperature. The other one 

serves as cooling unit for the laser and the motors. 

  

USER PC  
design positioning 
alignment sequences 
system parameters 
conversion: CAD design 
 

conversion  
 

exposure data MLA 

Main Unit 

Flow Box 

sensors 

control 

cooling water supply 
for Flow Box 

cooling water supply 
for Main Unit 

ELECTRONICS RACK data 

Figure 1: System components 
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3.1 Lithography main unit 

The Main Unit comprises the following elements: 

▪ Flow box 

▪ Granite Construction  

▪ Optics System  

 FLOWBOX 

The flow box is the housing of the lithography system and protects the MLA150 from 

damage. It also provides a stable environment in terms of temperature, laminar flow and 

clean air. This is of importance because only such a stable environment guarantees 

constant exposure conditions which guarantees the smallest possible variation of 

exposure parameters. The covers of the flow box are removable, but only for service 

purposes. 

 

 

Injuries by moving parts or laser light! 

Severe damage to the eye and possibly to the skin can be 
caused by laser radiation of class 3B or 4 

• Do not open the covers of the flow box. 

• Flow box covers may be opened only by, or under direct 
instruction from, experienced service personnel! 
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ELEMENTS OF THE LAMINAR FLOW BOX: 

 

 

 

 

 

 

TEMPERATURE CONTROL UNIT 

The flow box is temperature controlled by means of regulated heating of the 
incoming air. The air is cooled down by the water-cooling unit and then reheated to 

1 TEMPERATURE CONTROL UNIT 

2 DISPLAY  

3 SWITCH PANEL 

4 CASTOR WHEEL 

5 WINDOW 

6 LIGHT 

1 ACTUAL TEMPERATURE 

2 TARGET TEMPERATURE 

3 RESET BUTTON 

4 HEAT OUTPUT REGULATOR 

Figure 2: Elements of the laminar flow box 

1 

2 

3 

4 

5 

6 

Figure 3: Temperature control readout 

1 
2 

3 

4 
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the required process temperature. The temperature control unit is located within the 
top compartment and has a display readout accessible from the outside through a 
hole in the flow box cover. In case the temperature exceeds +65°C inside the flow 
box, which can be caused by a malfunction of the fan, the control unit shuts down 
the heating system. The push button switch turns red. The heating system can be 
reset by pushing the button once but this should only be done if the reason for the 
failure is known. The display readout has a small icon in the left, blinking in regular 
intervals. This icon shows the activity of the heat output regulator. If the icon blinks 
periodically then the heat regulation works properly. If the icon is illuminated or not 
illuminated without any periodical change, then the temperature control unit is not 
working trouble-free anymore. It is recommended to shut down the system and call 
one of Heidelberg Instruments service offices (see 1.2 Contact). 

CASTOR WHEELS 

The flow box stands on eight castor wheels that have locking brakes to provide a 
stable position. These castor wheels are not height-adjustable. The machine is 
leveled by adjusting the four feet.  

SWITCH PANEL 

At the front side of the flow box several buttons are 
located. The button at the top is the emergency off 
button. For opening and closing the window, the push 
button is used. The flow box provides a light source for 
inside, which is, depending on the application, yellow or 
red light. The light switch is located between the 
emergency off button and the window push button. 

 

 

 

 

WINDOW 

The window is opened only for loading and unloading 
purposes. During operation, the window cannot be 
opened for safety reasons. The push button at the front of the flow box opens and 
closes the window by means of compressed air. This button is disabled while an 
exposure is running. 

 

  

Emergency Off 

Window push button 

Light push button 
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 SYSTEM COMPONENTS 

SYSTEM SUPPORT 

A heavy-duty aluminum construction and four buffers that are filled with air to ensure 
vibration isolation support the granite base plate. To avoid any unnecessary bending 
forces in the base plate, these buffers are arranged in a triangular geometry (the two 
buffers at the front side are close together and act as one point). 

HEIGHT-ADJUSTABLE FEET 

The granite construction stands on four height-adjustable feet. By varying the height 
of the feet the system is leveled in correspondence with the ground condition in the 
location the system is installed. The castor wheels of the flow box are not height-
adjustable. 

BASE PLATE (MAIN BLOCK) 

The main unit has a granite base that gives stability to the system. It has been 
selected for its low thermal expansion coefficient. The granite base plate is 
supported by air buffers that ensure effective vibration isolation and has threaded 
holes to accept other system components. Medium and high-power lasers are 
mounted at the bottom of the base plate to minimize heat generation in the areas 
that are sensitive to heat.  

OPERATOR PANEL  

The operator panel has a push button (1) that opens 
the vacuum inlet to fix the substrate on the chuck. 
For observing the vacuum status, a display (2) 
shows the current vacuum status. However, it is not 
necessary to observe the status because the wizard 
informs about vacuum supply problems. The panel 
also contains two or four LED lights (3) indicating 
the status of the laser(s). The lights are on 
throughout the whole exposure procedure. When 
the window is open, the lights are off indicating that 
the laser(s) is (are) off (see 4.2.3 Info Section).   

Figure 4: System support 

Figure 5: Operator Panel 

1 

2 3 
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STAGE SYSTEM  

The stage is equipped with linear motors in both axes. They provide smooth and 
constant movement with low positioning errors. One air bearing and one roller 
bearing support the movement in y-direction whereas the x-axis is equipped with two 
roller bearings.  

The stage carries the frame in which the chuck is located. The open frame chuck 
features a vacuum suction hole in the center and four small vacuum slits through 
which the vacuum reaches the substrate. One of the viewing slots is surrounded by 
a recess in which the adjustment aid is inserted to provide proper substrate placing 
on the chuck. The chuck can be exchanged by using the pressure clamping. The 
substrate is hold down and kept it in place by vacuum suction. The chuck features a 
vacuum suction hole in the center and four small vacuum slits through which the 
vacuum reaches the substrate. 

 

 

  

1 VIEWING SLOTS 

2 VACUUM SUCTION SLITS 

3 PRESSURE CLAMPING 

4 VACUUM SUCTION HOLE 

5 RECESS FOR ADJUSTMENT AID 

2 

1 

4 5 

3 
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OPTICS PLANE 

 

The optics system is located on a smaller granite top plate supported by the base 
plate and its granite side elements. The optics plane contains the optical elements 
and camera components. The write head stands at the end of the optical path and is 
mounted to this plate with downward beam direction facing the substrate. 

 

 

 

  

1 INTERFEROMETER HEAD 

2 CHUCK VACCUM SWITCH 

3 OPERATOR PANEL 

4 CHUCK CLAMPING 

5 STAGE 

6 CHUCK 

7 WRITE HEAD 

8 OPTICS PLANE 

Figure 6: Stage system with optics plane 
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 OPTICS SYSTEM 

DIGITAL MICROMIRROR DEVICE (DMD) 

The DMD is an electrical input and optical output micro-electric-mechanical system 
for spatial light modulation. It is composed of an array of micro light switches 
containing individually controlled micro mirrors which correspond to the pixels in the 
image to be displayed. Laser light is modulated by this device to project and transfer 
a pattern into positive or negative resist.  

LASER UNIT AND OPTICAL ELEMENTS FOR BEAM GUIDANCE 

The laser beam is emitted by several laser diodes, coupled in an optical fiber and 
projected on the DMD. The optical elements guide the modulated light through the 
system. The light beam passes the write head and is finally projected on the 
substrate. 

CAMERA UNIT 

The camera unit comprises one camera with low resolution, one with high resolution 
and one overview camera. The cameras feature a light source and are used for 
accurate alignment of a design with existing structures. Here, the High Res or the 
Low Res cameras are the appropriate choice due to their higher resolution 
compared to the overview camera. When the alignment marks are larger than the 
field of view of the High Res camera, switching to the Low Res camera is 
recommended. The overview camera can also be selected for alignment, but the 
accuracy is limited by its resolution (~50 µm). Therefore, this choice might be used 
for coarse structures. Keep in mind that the overview camera does not show the 
complete surface of the substrate due to mechanical limits. Systems with backside 
alignment have a second camera unit for back side viewing mounted inside the 
stage looking to the substrate.  

 

 

 

 

 

 

 

PNEUMATIC AUTOFOCUS 

The pneumatic autofocus serves to keep the focal point of the write beam stable on 
the surface of the substrate. For probing the distance, compressed air passes 
through the write head and leaves it through a nozzle. Once the write head is close 
enough to the substrate, a pressure builds up between the nozzle and the substrate, 
which is monitored by a pressure sensor. The pressure sensor transmits the signal 
to a controller which regulates the distance to the substrate. The defocus value 
shows the focus position of the write head with respect to the offered defocusing 

Camera type 
Field of View  
(size of the substrate area that can be seen) 

Top Surface Back Surface 

High Res  190 μm x 140 μm - 

Low Res  640 μm x 480 μm 640 μm x 480 μm  

Overview 12 mm x 9 mm top side only 

*Overview cannot access the entire surface of the substrate due to mechanical 
limits. 

Table 1: Field of view (top side, back side) 
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range [-10 to 10]. This range is necessary to adapt the focus distance to an 
appropriate value which mainly depends on resist thickness and thus varies.  

INTERFEROMETER 

The laser interferometer is an optical device for measuring the stage position. The 
machine achieves its required positioning precision with this important element.  
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Figure 7: Interferometer function 
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3.2 Electronics rack 

The electronics rack consists of several units. These units drive and control the system 

and provide communication with the operator of the system. The following electronic 

units are located inside the electronics rack: 

1 USER PC WITH CONVERSION  

The User PC is a communication interface 
between user and system by means of the 
graphical user interface (GUI). The User PC 
runs Linux on a virtual machine which runs the 
conversion software. This software is necessary 
for design conversion. Design files in Gerber, 
DXF, CIF or GDSII are converted into a 
machine file format which can be read by the 
MLA system.  

2 POWER SUPPLY AND EMERGENCY STOP 

 MODULE 

This unit is for power distribution. It also 
contains the buttons for Power On (green) and 
Power Off (red).  

3 STC-RACK 

The STC-Rack controls the several motors and 
the autofocus system.  

4 INTEGRATED NETWORK HUB 

The Integrated Network Hub connects the 
multiple devices and make them work together 
on a single network. 

5 STAGE CONTROLLER 

The Stage Controller drives the stage, reads 
the interferometer data, triggers the laser and 
the DMD (digital micromirror device)  

6 STAGE AND LASER CHILLER 

This chiller is integrated into and powered via the electronics rack. It serves as 
cooling unit for the laser and the stage.  
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Figure 8: Electronics rack 
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3.3 Orientation of stage and design 

It is important to load the substrate with the correct orientation on the center of the 

chuck. The coordinate system of the design to be exposed must match the direction and 

orientation of structures already exposed on the substrate. 

The coordinate system of the stage is oriented such that the y-axis corresponds to a 

left-right movement and the x-axis to a backward-forward movement (see Figure 9) 

when standing in front of the machine.  

 

 

The design is exposed rotated by 90 degrees in clockwise direction (Figure 10). 
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Figure 10: Machine-related design rotation 
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Figure 9: Orientation of stage and design 
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Thus, the coordinate system of the design is also arranged rotated by 90 degrees 

clockwise (Figure 11).  

 

For easier orientation on the chuck regarding the design coordinates, the following 

figure gives an example of alignment crosses and their location on the substrate.  
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Figure 11: Rotation of coordinate system on chuck 
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3.4 Chuck exchange 

 To install a different chuck, loosen the clamp by flipping the chuck pressure switch 

so that the pressure supply of the clamping is interrupted.  

 Take the chuck off the frame.  

 Put the other chuck into the frame.  

 Remove your fingers from the chuck and do not touch the clamp. 

 

Pinch point at pressure clamping!  

Keep fingers away from the clamp when flipping the switch 

for closing the clamp.  

 Flip the switch again, so that the pressure supply is released.  

 

  

Figure 13: Pinch point at pressure clamp 
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The MLA150 offers quick setup of exposure and alignment aided by the Exposure 

Wizard. This intuitive user interface guides the operator through the steps of an 

exposure set up. To start the wizard, double-click on the link icon. 

4.1 Overview: Exposure Wizard  

The Exposure Wizard has its own window. This window stays open throughout the 

entire configuration and exposure procedure (Figure 14). It contains the following main 

elements:  

MENU BAR 

TREE View  

INFO SECTION 

FRAMES 

INFO FIELD 
NAVIGATION 

BUTTONS 

PANEL 

Figure 14: Wizard window overview 
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MENU BAR  

The menu bar is located at the top of the window, offering several menu utilities. 

INFO SECTION  

The info block gives information about the hardware condition and the progress or 
status of the current exposure setup.  

PANEL  

The panel is located below the info section. This panel changes according to the 
tasks that the system has to perform. In figure 14 the panel’s name is Setup Job 
panel. Inside the panel are buttons and frames. 

FRAME 

The panel contains frames e.g., the Layer frame, where the design file and other 
options are selected. The frame has mandatory fields that have to be filled with 
values, and fields that can be filled optionally. The mandatory fields are highlighted 
in orange and turn green once a value has been entered. The optional fields are 
highlighted in green before and after the entry of values.  

Throughout this manual you find instructions like "double-click Design". In this case, 
you are instructed to double-click the value field with the title Design not the word 
Design. 

BUTTONS 

A click on these buttons usually opens another window where you can select items 
or set options 

NAVIGATION BUTTONS (PROCEED FRAME) 

At the bottom of the wizard window, you find navigation buttons e.g., Load 
Substrate or Continue. The functions and names of the buttons depend on the 
selected exposure mode. These buttons can stay disabled until certain tasks are 
finished.  

INFO BOX 

Every panel contains a yellow text box, giving information and instructions on the 
current task.  

TREE VIEW  

A tree view shows the procedure steps the system has to execute. T (refer 4.2 Static 
Wizard Elements for more details). 

INFO SECTION  

The info section contains four blocks giving information on system conditions as well 
as information on the current exposure process.  

In the following subchapter, you find detailed information about the Exposure Wizard 

elements.  

TITLE 
VALUE 

MANDATORY OPTIONAL 



 MLA150 
4 Wizard description  

 

 

 
User Guide  29 

4.2 Static wizard elements 

 MENU BAR 

File→Exit: To leave the wizard and close the window 

Tools→Control Panel: Activates the Control Panel (see 7.1 Control 
Panel) 

Tools→Initialize Backside Lens To initialize the lens for the backside function. 
In the dialog window, click Yes to start the 
initialization process.  

Tools→Initialize Stage: To initialize the stage in case the hardware info 
shows that it is not initialized. In the dialog 
window, click Yes to start the initialization 
process.  

Tools→Backup  For back up of system files. 

Tools→Laser Measurement To measure the laser power in order to 
compare it with the value measured during the 
most recent laser calibration procedure. 

Tools→Large Camera Defoc In Alignment Mode, the focus settings can be 
switched to larger camera defocus with a wider 
defocus range. 

Tools→Logging  Required for HIMT Service only. Do not 
change the settings as long as no service 
engineer demands it.  

Tools→Beam Offset To measure and adjust the beam offset.  

User Management→ChangeUser:  For changing the user type. 

Info→Exposure info Shows information about recent exposure jobs. 

Info→Startup info Shows information about the condition of the 
system after startup. 

 TREE VIEW  

The tree view shows the steps to be completed with the 

wizard from job setup to exposure and unloading. It is a 

graphical representation of the sequence of panels making 

up one exposure job. As a kind of panel map it can be taken 

for orientation.  

The green rectangle shows the options available in the 

selected Exposure Mod. The green tick indicates that the task 

is done.  
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 INFO SECTION 

The Info Section consists of four subsections: 

▪ Exposure Info 

▪ Alignment Info 

▪ Progress Info  

▪ Hardware Info 

 

Exposure Info 

 

• Job Name is a combination of the word job and the job number. It is editable in the 

Job frame by double-clicking into the Job Name value field. 

• No. shows the auto-incrementing number of the job, it is not editable. 

• Substrate Size[mm] shows the size of the substrate that is currently loaded. 

• Design Name shows the name of the design that is currently loaded. 

• Design Type shows if it is a binary file or not.  

• Convert shows the type of conversion process, online or offline, depending on the 

design type.  

• Design Size [mm] shows the size of the design. 

• Dose [mJ/cm²] shows the exposure energy for the current job. 

• Height shows the height of the substrate on the chuck. 

• Layer shows the layer that is currently being prepared for exposure. 

• Mode shows the exposure quality level chosen at conversion. Quality means high 

level, Fast means lower quality level but faster completion. 
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• Defoc shows the defocus value selected for the current exposure. The defocus with 

a range between -10 to 10 allows for fine tuning of the exposure focus (for more 

information see 3.1.3 Optics System: Pneumatic Autofocus). This value can be 

adjusted before starting the design exposure (6.9 Expose Design)  

 

Alignment Info 

 

This info box shows two tables: 

Expose Cross Positions shows the positions of the alignment crosses set during the 

setup of the layer previous to the layer with the design that is to be aligned. For 

instance, when setting up the First Exposure job the coordinates of the exposure 

crosses for the next layer can be determined and exposed together with the First 

Exposure layer.  

Align Cross Positions shows the positions of the alignment crosses taken from the 

template file. For orientation regarding the location of the coordinate pairs on the 

substrate see 3.3 Orientation of Stage and Design.  

 

Progress Info 
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The Progress Info box gives information about the progress of the exposure.  

• Exposure Status shows the status of the exposure job.  

• Design Number shows the number of the design that is being exposed. 

• Stripe Number shows which stripe is being exposed at the moment. 

• Time [hh:mm]. shows the time that the exposure takes in total. 

• Remaining Time [hh:mm] shows the time that the exposure is still requiring to be 

finished. 

 

Hardware Info 

The Hardware Info box shows important information about the system status. The 

Refresh button updates the information stated in the tables. The Stage Position fields 

show the x-coordinate and the y-coordinate of the current stage position. A click on 

Refresh updates the fields to show the current position. 

The Status list informs about the status of the system devices. If any status shows red 

instead of OK, click Refresh. If the status is still the same, go to the Info Tab and click 

Status Messages. Here, you can see why the status does not show OK.  

The Numeric Values list shows the condition of the system parts in numeric values. 

These values are only interesting for service staff. If any of the numeric values is not in 

the normal range, the Status list shows red instead of OK.   

REFRESH  STAGE POSITION  
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 EXPOSURE INFO 

By selecting Info→ Exposure Info from the menu bar, a table opens containing a list of 

exposure jobs recently done and their exposure data. The page features a search bar 

for easy retrieval of exposure information. 

 

 

 STARTUP INFO  

The control system checks the communication between the electronics and the 

hardware components. A list gives an overview of the components and their function 

status. All list items should be marked green. If there are items showing a red cross, 

wait a couple of minutes so that the user menu can complete startup. If there is still a 

red cross, restart the user menu and in case the red cross is still visible, switch off and 

on the system. In cases in which this procedure does not lead to success, call 

Heidelberg Instruments Service. If the stage shows a red cross, try to initialize the stage 

with Tools→Initialize Stage.  

 

  

Note: If the Hardware Info Section shows red, open the Info Tab and check the 
startup messages to locate the problem.   
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4.3 Tooltips 

The wizard features tooltips. Tooltips are also elements of a graphical user interface, 

but they are not static such as the menu bar or informative fields. The tooltip appears 

when the user hovers over an item in the GUI without clicking on it. It disappears when 

leaving the surrounding of the item o clicking on it.  

If one of the navigation buttons in the lower part of the wizard window is grayed out, it is 

not possible to proceed with the task. When hovering over the Proceed frame 

containing the navigation buttons, a tooltip informs about missing information that is 

required to fulfil the respective task.  

 

 

4.4 Substrate representation 

In the menu panel, you find a simple graphical depiction of the substrate showing the 

design position on the substrate. The position of the camera is also displayed in order to 

see which part of the substrate is currently visible in the camera image.  

 

 

Design is missing 
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Depending on the kind of substrate shape (round or rectangle) the menu offers two 

different substrate visualizations. On the substrate, the design position and size are 

displayed by a red rectangle. The camera is depicted as a blue rectangle.  

The horizontal and vertical solid lines indicate the real size of the substrate. The size of 

the design representation and the size of the camera are scaled in relation to these 

measure lines.  

To move the design to a certain position on the substrate, use the Control Panel. 

Alternatively, drag the camera rectangle to the desired location. The design follows 

when the camera position is set to zero by clicking Set zero in the Control Panel. 

  

1  Camera 

2 Design 

1 

2 
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4.5 Loading panels 

Loading panels are part of the wizard. For design loading, job loading and template 

loading (series, substrate, resists) the sheets for loading contain a list of existing items 

but it is also possible to set up new templates or save new designs.  

All loading panels are arranged in the same way.  

 

 

(1) At the top there is a bar with buttons, text fields, radio buttons or checkboxes.  

Load frame  
Load To load an item to step in the current 

application 

 

Cancel To cancel the loading procedure and go 
back to the previous panel 

Refresh  To refresh the list. 
Search Frame  
Search  To search for a listed item, enter the 

name in the text fi 

 
Search To start the searching process.  
Clear To clear the content of the search text 

field.  
Show frame   
all To show the entire list.  

 

next To determine the next number of items 
by the value selected from the drop-
down list.  

next (button)  To show the selected items.   
Show only 
templates 

To only list up items of the type 
“template”.  

 

1 

2 
3 

4 
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(2) Below this bar a list shows all designs available or the items that are saved as 

template. All information and parameters are listed in the columns of the table. 

 

 

(3) In the left part of the panel, a table with parameters is given. In this table new 

templates can be created, or the existing ones can be changed. These tables are 

explained in the respective chapter where loading and template setup are described.  

(4) Below this table, buttons arranged in the Edit frame allow to make changes in the 

table.  

 

Edit frame 

New To set up a new item for the list (template or design).  

Edit To edit existing designs.  
Save To save the newly created or edited item.  

Delete To delete the item from the list.  
 

Note: Some of the functions are restricted to Staff user group.  
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This chapter describes how to power up and power down the MLA150. For powering up 

and down the system the buttons at the front of the electronics rack are used.  

5.1 Powering up 

Powering up the system:  

 If not already done, switch on the main switch at the 

electronics rack. Allow 60 seconds to boot the power 

supply.  

 Switch on the User PC. 

 To switch on the system power, press the On (I)-button at 

the electronics rack.  

 You can hear one click and another click 3 seconds later.  

In case the system was switched off by using the EMERGENCY OFF button: 

 Release by turning it in the direction indicated on the button. 

Otherwise the system power cannot be switched on.  

 Press the green On (I)-button in the electronics rack. 

 You can hear one click and another click 3 seconds later.  

Note: If power is not coming up, check whether the main 
switch in the electronics rack is turned off. Turn on the 
main switch again! 

 Switch on the displays and the User PC, if they are not running. 

 

In case the power supply was interrupted (e.g. by a blackout) 

 Press the green On (I)- button.  

 You can hear one click and another click 3 seconds later 

 Reboot the User PC.  

Starting the Exposure Wizard: 

 Click the shortcut of the MLA150 menu at your desktop.  

 At each startup, the menu checks for initializations of necessary components. A 

window shows the status of hardware initialization 

1 main switch 

2 On (I) 

3 Off (0) 

 

1 2 3 

Emergency  
Off 
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5.2 Powering down 

Powering down in emergency case: 

In case of emergency, press the EMERGENCY OFF button at the front of the flow box. 

Standard power down procedure 

 Close the Exposure Wizard by selecting File→Exit from the menu bar. 

 Shut down the User PC. 

 Press the red Off (0) – button at the electronics rack. 

 The system shuts down. 

 

Complete Shutdown 

Execute the standard power down procedure and then turn off the main switch that is 

located on the front of the power distribution rack in the electronics rack (see 3.2 

Electronics Rack). 

Note: • In general, the system should be powered down completely only if 
absolutely necessary. If the exposure laser is off, idle power consumption of 
the system is low, and keeping it in standby enhances stability. 

• We do not recommend to power down the system if the idle time period is 
less than one week.  

Powering down for maintenance 

The main switch of the power supply module in the 

electronics rack is equipped with holes for a padlock. If 

the system is powered down for maintenance or 

servicing, after above steps, secure the main switch in 

the Off position with such a padlock. 
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5.3 User login 

There are three user log-in types available. Standard, Staff and Service: 

Standard is the default user type when opening the menu. No password is required and 

the user can set up and execute exposure procedures.  

Staff requires the entering of a password. This user type has the permission to create 

resist templates, job templates and edit a few settings.  

Service user type is for HIMT service staff only.  

For switching user types follow the instruction below:  

 Select User→Change User from the menu bar. A login window opens.  

 Select the user type from the drop-down list and enter the password, if required.  

 Click the Login button.  

 

If the active user type is switched to Staff, this is indicated in the menu bar together with 

a logout button.  
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As mentioned before (4 Wizard Description), the MLA150 provides an exposure wizard 

that guides the user through the steps needed to perform an exposure. The following 

subchapters build a sequence of actions that must be executed one after the other. To 

use the wizard efficiently, follow the instructions given in this chapter. The following 

figure is a “panel map” showing the way through the wizard panels.  

 

 

 

 

 

  

Load 
Substrate 

Unload 
Substrate 

Setup Job 

Select Job 

Select Substrate 
Template 

Load Design 
(Convert Design) 

Alignment: 
Exposure 
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Exposure 
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Draw Mode 
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6.1 Select job 

 To start the wizard, double-click the MLA shortcut icon on the desktop.  

 The Exposure Wizard opens and automatically creates a new job. This job has a 

Name and a Number. The name is editable and can be changed by clicking into 

the Name field. The number is fixed and auto-incrementing.  

 From the dropdown list, select one of the available exposure modes: 

Standard: To expose a single design for each layer. Overlay 
exposures are possible in this mode. 

Series: To expose designs (e.g. dose test) several times at 
different positions with varying parameters (dose or/and 
defoc). It can also be used for finding the appropriate 
dose and defoc relation for the exposure. 

Draw Mode: To create boxes, circles or ellipses of arbitrary size limited 
only by the camera field. Used for creating connections 
between structures or for repairing imperfections in 
structures of an exposed layer. 

Inspection: To inspect and measure the exposed structure.  

If you do not intend to use the new job, you can also choose from the following options:  

Continue or repeat a job: 

Click Load Job. A list appears from where you select the required job. 

Repeat an exposed layer of that job: 
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Click Restart Job and select the job you would like to repeat. The process data of the 

selected job is deleted, and a new job is set up with the same settings but with a new 

job name/number. 

Start another new job after you have finished an exposure job: 

Click New Job. The new job has a new number and a new, but editable, name. 

Continue with the instructions for a new job. 

After you have set up the desired job, choose the appropriate substrate and the 

corresponding substrate template at the system (see 6.2 Select substrate template). 
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6.2 Select substrate template  

The system also needs the information about the chosen substrate. It offers a list of 

templates. In case the required template is not available in the list, it is possible to load 

a new substrate template (only for authorized users).  

For selecting a substrate template, follow these instructions: 

In the Substrate frame:  

 Double-click into the value field titled Substrate Template. 

 From the list, select your substrate size or at least the shape e.g., automatic_round 

if you intent to load a wafer. 

 Above the list, click Load. 

 The Substrate frame now displays the selected substrate size or shape and the 

field is highlighted in green. The task of substrate template selection is done. If a 

substrate size was selected, the fields Size X, Size Y, Diameter and Thickness are 

filled with the corresponding value. 

 

 

   

1 1 

3 

2 
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6.3 Select a series template 

Note: Only for series exposures.  

In series exposures, the template as well as the design and other parameters are 

selected in the Series frame.  

 For selecting a new series templates, click into the Series Template field.  

 The Load Series panel opens. 

 From the list, select a template by highlighting it. 

 Click Load.  

 The template name appears in the Series Template field and is selected for the 

current series exposure.  

Set up Series Templates 

It also possible to create series templates. 

 Click into the Series Template field. The panel opens.  

 In the Edit frame, click New. The table in the left is now editable.  

 Fill in the information required as stated in the Series Exposure section further 

down.  

 After completing the table, click Save. 

 The template can now be loaded and used for future applications.  
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6.4 Load design 

In Draw Mode there is no design loading procedure because this mode is for 

exposing boxes, circles and ellipses of arbitrary size limited only by the camera 

field. Skip this subchapter and go to 6.5 Load Substrate. 

After you have selected one of the exposure modes (see 6.1 Select job) and determined 

the appropriate substrate template (see 6.2 Select substrate template), you load the 

design. For loading a design that is not in the list, follow the instructions given in 6.4 

Convert Design. The following sections contain instructions on design loading. Even 

though the loading procedures differ only slightly from each other in the different modes, 

read the section that corresponds to the exposure mode you are about to use. 

In the Layer frame, the button bar at the bottom offers to copy an entire layer. 

Mark the layer and click Copy Layer. The new layer will be added below the 

original one. To delete a layer from the list, mark the layer and click Delete Layer. 

 STANDARD: FIRST EXPOSURE 

In the Layer frame: 

 If available, select a laser from the dropdown list in the Laser field. 

 Double-click into the value field titled Design. A panel opens containing a list of 

available design files.  

 From the list, select the required design with a left-click. 

ii i 

ii i 
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 Click Load. Alternatively, double-click on the design name. 

 The design is now listed in the Layer frame. 

 Optional: Double-click the value field titled Resist and select the appropriate resist 

type for your application. In the Thickness field, the thickness of the resist is 

displayed. Select the wavelength for the exposure.  

Note: For exposures with grayscale optimization, the corresponding resist must be 

loaded. In this case, the field is not optional (see next section for grayscale 

resist loading). 

 Optional: It is possible to load a template for alignment crosses/shapes to be 

exposed on the layer. To load this template, double-click into the value field titled 

Expose Crosses and select a bitmap template file from the list. If the template size 

exceeds 800 x 600 px, the system shows a warning.  

 LOADING GRAYSCALE EXPOSURE OPTIMIZATION RESISTS 

The system supports grayscale exposures with design of the formats BMP or Grayscale 

DXF. Loading the design is the same procedure as for binary designs. 

If optimization is required, the corresponding resist must be loaded. The resist can be 

set up and saved only by users with Staff user rights, but users of the Standard login 

group can select the existing resists for the current job (for more information see 6.9 

Expose design). 

 After having selected the design, in the Layer frame, click into the Resist value 

field. 

 From the list, select the required resist and click Load.  

 The resist template contains all information for the optimized exposure.  

Note: Only Staff login group members can set up new grayscale optimization resists.  
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 STANDARD: ALIGNMENT 

For aligned exposures, Layer 2 is the first layer that can be chosen.  

Adding an empty layer is easy by clicking Add Layer. The new layer will be added 

below the current one. Alternatively, by double-clicking into the empty range 

bewlo the actual layers, a new empty layer is added. To copy a layer, click Copy 

Layer.  

 

 If available, select a laser from the dropdown list in the Laser field. 

 Double-click into the value field titled Design in Layer 2. A panel opens containing 

a list of available design files.  

 From the list, select the desired design file with a left-click.  

 Click Load. Alternatively, double-click the name.  

 The design is now listed in the Layer frame. 

 Double-click into the value field titled Alignment Settings. A list opens showing 

several templates with the crosses required for alignment procedures. Select one 

of the templates and click Load. The template is used for the alignment procedure. 

1 4 

ii i 
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A special template called _Manual. is offered for cases in which the cross 

positions should be selected in the alignment setup. The exposure is then executed 

with the manually selected alignment positions which are saved afterwards as 

[jobname]_AlignPos_L[No. of layer] (see below). Additionally, if a 

different template was selected, alignment positions can be changed or even 

ignored (see 6.8 Setup overlay alignment). 

 From the list, with a left-click select a template and click Load. 

 The template file is now listed in the Alignment Settings field. 

 Optional: Double-click into the value field titled Resist and select the appropriate 

resist type for your application. In the Thickness field the thickness of the resist is 

displayed. Select the wavelength for the exposure 

 

 SERIES  

In Series Mode, the template and design file are selected automatically when choosing 

Series Mode in the Setup Job panel (see 6.1 Select job). The Layer frame turns into 

the Series frame with different parameters than displayed in the Layer frame (see 

below).  

In case you need a different design file for your series exposure, follow the instructions 

given in 6.4.1 Standard: First Exposure. 

  

Note: If the first layer does already exist on the substrate, it can be easily skipped.   
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6.5 Convert design 

If you have chosen a listed design file, skip to the next section 6.6 Load Substrate. For 

converting a new design, follow these instructions: 

In the Layer frame: 

 Double-click into the value field titled Design. A page containing a list of designs 

opens. At the top you find a button bar.  

 Click Convert Design. You are led to the conversion software window. 
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In the Conversion window:  

 

 From the menu bar, select File →New Job (alternatively click the sheet icon). 

 You are asked to enter a name for the job. Enter a name and click Ok. 

 Click Add, select a design format. A directory opens containing the source files for 

the selected design format.  
  
 

To load a design from an external storage media into the corresponding HIMT 

folder, copy the external design file to the directory: 

HIMT\Designs\<design type>. 

 

 From the directory, select the file to be converted into the LIC format.  

 If necessary, change settings and / or use the viewer application (see related 

document Conversion Job Manager for more details).  

 Click Complete Task. A message box informs about the completion of the 

process.  

 If the status bar shows 100%, click Finish.  

 Click into the wizard window to refresh the design list or click Refresh. The new file 

is now listed and available for exposure. 

  

ii i 
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6.6 Load substrate  

After you have chosen the appropriate substrate, selected a substrate template and 

loaded a design, you can place the substrate on the chuck. The following instructions 

guide you through the loading procedure. You also get on-screen instructions inside the 

yellow Info Box.  

The chuck is designed to facilitate the manual loading process. It has an indentation 

surrounding one of the four viewing slots for backside alignment. This indentation 

makes substrate handling on the chuck easier as it offers space for putting the 

adjustment aid inside.  

ADJUSTMENT AID 

The guide bar at the bottom of the adjustment aid is equipped with rest positions 

corresponding to the different wafer sizes that are possible to be loaded on the chuck. 

These rest positions are made visible on a measuring scale. On the other edge, some 

marks help to center the wafer flat.  

In the example, the chuck is loaded with a 4” wafer as it can be seen on the measuring 

scale matching the mark at the chuck.  

Remove the adjustment aid from the chuck before starting the exposure. To avoid 

possible damage caused by this adjustment aid, the system is equipped with a 

monitoring function based on a sensor. The exposure function stays blocked until the 

tool is removed from the chuck.  

 

  

Figure 15: Loading substrates of normal size 
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SMALL SUBSTRATES ADJUSTMENT AID  

Take the adjustment tool for small substrates and put it onto the chuck so that it fits into 

the designated recesses. Put the substrate into the hole in the middle of the adjustment 

tool. Remove the tool from the chuck and switch on the vacuum.  

  

Figure 16: Loading substrates of small size 
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 STEP-BY-STEP SUBSTRATE LOADING 

In the Setup Job panel: 

 Click Load Substrate. The stage moves to loading position.  

 The wizard moves on to the Load Substrate panel. Wait until the movement has 

stopped.  

 

At the lithography main unit: 

 Push the window button and release it again. The window opens. 

 Place the adjustment aid so that the guide bar at the bottom fits into the 

indentation at the chuck.  

 Adjust the tool’s position to the substrate size.  

 Use a tweezer to grab the substrate and place the substrate on the 

chuck. 

 At the operator panel press the vacuum button. 

 Make sure that the substrate is held tight by the vacuum. 

  Remove the adjustment aid from the chuck.  

 Check the substrate's orientation (see 3.3 Orientation of stage and 

design).  

 Close the window by pushing and releasing the button. Go back to the User PC. 

 In the Load Substrate panel, click Continue.  

 Check if the substrate is placed under the write head. If not, see below. If the 

substrate position is correct, click Continue.  

 
Resist coated substrates get useless when exposed to 
white light! 
Non-safe light may only be switched on if all substrates are 
stored in boxes impermeable to light. Otherwise, the 
substrates become useless. 
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Note: In case the substrate is not placed under the write head, click Cancel. The 
stage moves back to loading position. Start the loading procedure again 
and make sure that vacuum is switched on.  

  

Note: If the substrate size has not been completely defined in the step of 
substrate template selection, the system issues a dialog box. Select one of 
the offered options. 

  

 The system searches for the center of the substrate (Find Plate Center) and gives 

information about the progress via a message box. For best results, the process 

gets repeated several times. If you wish to abort the Find Plate Center procedure, 

click Cancel. The system goes back to the Setup Job panel and unloads the 

substrate 

Note: For small substrates, the automatic center detection does not work. Here, 
the system asks the user to set the center position manually or to confirm the 
current position (see 6.6.2 Loading small substrates) 

 The system also detects the flat positions and calculates the rotation angle of the 

substrate. It is possible to select or deselect the angle for the exposure.  

After the successful loading process, the system leads to the next panel:  

In Standard Mode with overlay alignment, the Alignment panel appears (6.8 Setup 

Overlay Alignment).  

In Draw Mode, the system offers the Draw Mode panel for creating boxes, circles and 

ellipses (6.7 Draw Structures). 

In Standard Mode without overlay alignment, you are led directly to the Exposure panel 

(6.9 Expose Design). 

In Series Mode, the Series panel shows up offering the exposure procedure (6.9.6 

Series exposure procedure).  
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 LOADING SMALL SUBSTRATES 

As mentioned in the section above, for small substrates (up to 9 mm) the automatic 

center detection (Find Plate Center function) might not work.  

After having clicked Continue in the Load Substrate panel (step number 12), the 

system searches for the center of the substrate. For small substrates this procedure 

might not work properly. There are three possible result situations:  

Automatic center detection Result evaluation User action 
    

a→ Center position found Correct No action required 
    

b→ Center position found Not correct Action required* 
    

c→ Center position not found Warning message issued Action required* 

* Manual centering is required to set the correct center position of the substrate. 

 

If the system issues a dialog box informing on the failure of the automatic center 

detection as well as on how to proceed, take the following action: 

 Read the instructions given in the info box. 

 Click Ok and in the camera window a crosshair appears. Place the crosshair in the 

center of the substrate.  
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 Confirm with a click on the left mouse-button. In the Load Substrate panel, the 

yellow info box issues a warning and gives instructions on how to proceed.  

 

 Pay attention to the content of the info box. Only click continue if the center is 

below the crosshair center. Otherwise, click Set Position and repeat the manual 

centering with the crosshair.  

Note: The button Set position can be used as often as required until the center is 

set.  

 If the substrate center is below the cross and the center is finally found, click 

Continue.  

 The system is executing an automatic centering procedure based on the center 

position manually set.  
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6.7 Draw structures 

After having selected the appropriate substrate, you can start drawing the image. 

 

In the Draw Mode panel 

In the Procedure frame, select the kind of shape to use for image drawing by activating 

the corresponding radio button: 

Draw Image: Activate this option to use the shapes offered in the camera window: 

rectangle, ellipse, circle or bitmap file.  

Draw Line or Polygon: Use this option to draw lines or polygons (lines with more than 

two points). Adjust the line width by using the spin control below the radio button.  

Expose crosses: Use this option to expose crosses or shapes for alignment orientation 

without the design (in Standard Mode a design has to be loaded). In the Expose 

Crosses table, you can load the bitmap file for cross exposure. From external storage 

media, copy the template file to the directory HIMT\Designs\Bitmap.  
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 DRAW IMAGE 

 

 Click Draw Image and select the area for the structure on the substrate inside the 

camera window (use the Stage Control section for moving on the substrate).  

 In the camera window select the shapes of the structures that should be drawn 

onto the substrate by clicking on the corresponding icon.  

You can also load an existing file by clicking Load and selecting the file from 
the corresponding folder (usually C:\HIMT\Designs\Bitmaps). To directly 

load a bitmap file, click BMP located below the structure icons.  

 To drag the structure to the desired position, click into the structure and move the 

cursor with the mouse button held down. To rotate the structure, click into the 

green dot inside the structure and move the cursor without releasing the mouse 

button until the desired position has been found.   

ii i 
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 To confirm the drawn image, click Submit in the menu bar of the camera window. 

To clear the image, click Clear and start again. 

To save the image, click Save, insert a name for the file and save it. To cancel 

the entire drawing procedure, click Cancel.  

 

 After submission of the created image, work with the camera window is done. 

Return to the wizard window and the Draw Mode panel in which the exposure 

process can be started (see 6.9.6 Draw Mode exposure procedure). 

 

 DRAW LINE OR POLYGON 

 In the camera window, move to the area near to the 

position of the first point of the line or polygon, so that 

it is visible in the camera image.  

 Click Set Point.  

 In the camera window, a crosshair appears. Move the 

crosshair by moving the mouse to the desired 

position.  

ii i 
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 Click the left mouse button at the position in which the first point of the line should 

be set.  

 Move to the next point of the line/polygon by using the arrow buttons of the Control 

Panel.  

 Click Set Point. Repeat the set point procedure.  

 Check the line position in the camera window and click Accept line.  

 To draw a polygon, go on with the set point procedure and click Accept Polygon 

to submit the polygon drawing.  

 After accepting the drawn shapes, work with the camera window is done. Return to 

the wizard window and the Draw Mode panel in which the exposure process can 

be started (see 6.9.6 Draw Mode exposure procedure) 

 EXPOSE CROSSES IN DRAW MODE 

 

If not selected in the Setup panel a bitmap file has to be selected for every cross 

position: 

 Click Edit and select a template for every cross position. For selecting the same 

file in every position, activate the checkbox Use first bitmap for all. 

 Enter the positions into the table. 

 Click Apply, to leave the editing mode.  

 

Note: Use Edit to change the template selection made in the Setup panel. Go 
back to the original positions from the selected file, click Original.  
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6.8  Setup overlay alignment 

For exposing the first layer, skip this subchapter and continue with 6.9 Expose Design.  

The MLA150 is able to execute precise alignment exposures. In order to achieve best 

results, the system offers top side as well as back side alignment. Back side alignment 

(BSA) is realized by a separate camera unit for back side viewing that is mounted inside 

the stage and looks to the substrate. Back side alignment is used in the same way as 

the normal top side alignment. For using the available alignment modes, choose 

standard exposure mode in the Setup Job panel.  

Top side alignment is supported by three different camera types as mentioned before 

(see 3.1.3 Optics System). Back side alignment is supported by one camera. The 

overview camera is still active but provides only top side view on the substrate.  

For alignment, the High Res or the Low Res cameras are the appropriate choice due to 

their higher resolution compared to the overview camera. When the alignment marks 

are larger than the field of view of the High Res camera, switching to the Low Res 

camera is recommended. The overview camera can also be selected for alignment but 

the accuracy is limited by its resolution (accuracy ~50 µm). Therefore, this choice might 

be used for coarse structures.  

The alignment function offers two different alignment modes, CrossAlignment and 

ManualAlignment. 

• CrossAlignment is an automatic cross detection mode and is recommended to be 

used as standard mode.  

• ManualAlignment is the manual mode for cross detection and is provided for 

exceptional cases in which the automatic detection might not work properly.   

In this chapter, you find the information necessary for executing alignment for overlay 

exposures. The alignment procedures of top side and back side do not differ from each 

other, so the following instructions are for both alignment types.  
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Alignment Procedure 

In the Alignment panel: 

 

 If the template _Manual for manual setup of the alignment cross coordinates was 

chosen, select Top Surface for top side alignment or Back Surface for back side 

alignment from the dropdown list. The other templates already contain this 

information.  

 Choose a camera from the Stage and Camera Control panel:  

Top Surface  Back Surface 

 

 

 
 Field of view   Field of view 

High Res 190 µm x 140 µm   - 

Low Res 640 µm x 480 µm  Backside 640 µm x 480 µm 

Overview* 12 mm x 9 mm    

*Overview cannot access the entire surface of the substrate due to mechanical 
limits. 

Note: Using the High Res or Low Res camera for alignment is recommended 
whereas the Overview camera might only be useful for alignment 
procedures with coarse structures. 
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 From the Alignment Mode dropdown list choose between CrossAlignment and 

ManualAlignment. This selection can be made for every single cross position. 

 Double-check the positions of the alignment crosses taken from the template file. 

Editing: The Edit button is used for changing the alignment cross positions. Click Edit 

and enter new values. To delete one of the cross coordinates, delete the value and 

leave the field blank. If, for instance, you intend to skip the second cross position in the 

list, delete the value, copy the value from the third cross position field into it. Leave the 

third position field blank. To close the editing process, click Apply. The positions are 

stored in a temporary file and turned into a permanent template after exposure start. To 

restore the original positions from the file, click Original. 

If the template _Manual was selected, set the alignment marks manually by using the 

Edit function. For every alignment cross enter the coordinates and click Apply in the 

end.  

 Use the Stage Control frame of the Control Panel to move the cross into the 

camera center (see 7.1 Control Panel).  

Note: You can switch between continuous movement and stepwise 
movement. In step mode enter the step size [µm] for X and Y 
direction into the corresponding fields. In the continuous mode, 
change the driving speed [µm/s] either by using the slider or by 
clicking into the field and entering the speed manually into the 
corresponding field. Alternatively, click into the slider field to use the 
arrow keys for setting the speed 

 Determine the alignment marks in:  

A CrossAlignment Mode: 

Click Measure. The system measures the position of the cross and moves it to the 

center of the camera window. Examine the positions and click Accept Position to 

confirm it. The procedure moves on to the next alignment cross.  

 
In case of unsatisfying measurements see 7.2.1 Unsatisfying alignment 
measurements. 

B ManualAlignment Mode:  

Click Measure. In the camera window, a crosshair appears. Move the crosshair to the 

position in which the alignment marks should be set. 

Press S (square) or/and or C (circle) on the key board, a rectangle frame or a circular 

frame appear to support positioning into the center of the cross. Click the left mouse 

button to fix the position. The crosshair turns orange.  

Note: The frame can be enlarged or reduced by using the mouse wheel. 
Pressing C or S again makes the rectangle/circle disappear. To 
speed up the resizing of the frame, use Ctrl+mouse wheel. 

 i 
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To center the position of the alignment mark inside the camera window, click Center 

Cross.  

Note: It is possible to skip alignment positions by clicking Skip Position. This only 
works if more than two points are available otherwise the button is disabled. 
In the Pos field the rectangle turns red indicating that this coordinate pair 
was ignored. 
 

 Repeat the procedure for all alignment cross positions.  

 Click Continue. 

 The design is now prepared for the exposure process. For information on how to 

start the exposure process, go to 6.9 Expose Design. 

Note: Restarting the alignment procedure is possible by clicking Cancel. 
Alternatively, with Setup Job the alignment procedure gets cancelled and 
the Exposure Wizard moves back to the Setup Job panel.  

 

  

Figure 17: ManualAlignment with support frame 



 MLA150 
6 Job setup  

 

 

 
User Guide  67 

6.9 Expose design 

The system offers two standard exposure modes, one with and the other one without 

overlay alignment. Additionally, it is possible to execute series exposures in order to 

determine the appropriate defocus settings and dose settings for the current exposure 

job. In Draw Mode, you skipped the design loading and created your own structures 

directly on the substrate inside the camera window (6.7 Draw Structures). The following 

sections give instructions on how to execute exposures in the different modes.  

Note: Depending on the system configuration, the autofocus is switched off 

automatically when no exposure or measurement is running.  

 FIRST EXPOSURE PROCEDURE 

After having loaded the design and the substrate, you are in the First Exposure panel.  

 Double-check the design name and the wavelength. 

 Double-check and, if required, edit the Dose by entering the value into the text 

field. 

 Set the Defoc by selecting a value with the spin button [-10 to 10] (extended 

defocus range [-25 to 25] depends on the resist template, see note below Fehler! 

Verweisquelle konnte nicht gefunden werden.). The defocus allows for fine 

tuning of the exposure focus.  
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Note: The extended defocus range is only available if the corresponding resist 
was selected. Only users of the Staff user group are allowed to set up such 
resists (8.5.3 Staff: Exposing with extended defocus range).  

 

 Optional: Activate Auto-Unload (see 6.10 Unload substrate). 

 Optional: Activate Expose Crosses if having selected a template before (see 6.4.1 

Standard: First Exposure). Use Edit to change the coordinates or load a different 

file. It is also possible to load a template here if not having done it before in the 

design selection. Use Original to reset the coordinates to the values given by the 

template file. 

 Optional: Activate the Expose with substrate angle checkbox if you wish to 

expose with the rotation angle of the substrate on the chuck.  

Note: Important! If you activate the Expose crosses checkbox, also activate the 

checkbox Expose with substrate angle so that the angle is counted in when exposing 

the crosses. This is important for correct alignment results.  

 Click Start Exposure.  

 The machine is exposing the design. If Auto-Unload is 

not activated, then after completion of the exposure a 

dialog window pops up asking if the substrate should be 

unloaded. Click Yes, if you want the system to unload the 

substrate or No if the substrate should stay loaded on the 

chuck e. g., to expose the next layer.  

 

 GRAYSCALE OPTIMIZED EXPOSURE (OPTIONAL) 

The system supports grayscale exposures. After having loaded a grayscale design of 

the formats BMP or Grayscale DXF, the First Exposure panel opens. The procedure is 

the same as in the First Exposure panel for binary designs, unless grayscale dose 

optimization is required for satisfying exposure results. This can be achieved by 

changing the distribution of the total dose to the gray value bits (only possible if the 

corresponding resist was selected, see 6.4.2 Loading grayscale exposure optimization 

resists). 

 In the First Exposure panel you find a Grayscale Optimization frame. Within the 

frame, activate the checkbox Set individual Doses for each Bitlayer. 
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 A table opens showing the gray value bits in the top row and the corresponding 

dose values. The distribution of the total dose to the gray values is saved in the 

template and can be used. It is possible to change this distribution pattern for the 

current job but cannot be saved to the template. 

Changing the distribution pattern for the current job 

 Click into the fields and enter different values to change the distribution of the total 

dose to the gray value bits.  

 After having distributed the total dose to the grayscale values, you can start the 

exposure as usual.  

 OVERLAY EXPOSURE PROCEDURE 

After having loaded the design and the substrate and having prepared the alignment 

marks, the substrate is ready to be exposed.  

In the Alignment: Exposure panel 

 

 Double-check the design name and the wavelength.   

 Double-check and, if required, edit the Dose value by entering it into the text field. 
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 Set the Defoc by selecting a value with the spin buttons [-10 to 10] (extended 

defocus range [-25 to 25] depends on resist templateFehler! Verweisquelle 

konnte nicht gefunden werden.). The defocus allows for fine tuning of the 

exposure focus. 

 Optional: It is possible to load a template for alignment crosses or shapes which 

are exposed on the layer. To load this template, double-click into the value field 

titled Expose Crosses and select a bitmap template file from the list 

 Choose from the Alignment Options section:  

▪ Rotation [mRad]: This option is recommended and selected per default. If the 

Use checkbox is activated, the system includes the rotation of the substrate.  

▪ Scaling X/Y: The system compares the distance measured during alignment with 

the distance given by the alignment positions (minimum 3 positions). From the 

deviation a scaling factor results. Based on this, the alignment design is shrunk 

or stretched in order to match the previous layer.  

▪ Shearing [mRad]: The system compensates small distortions such as a 

rectangle that appears more like a parallelogram.  

 Optional: Activate Auto-Unload. The system executes the unloading procedure 

automatically (see 6.10 Unload substrate). 

 Click Start Exposure. 

 The machine is exposing the design. If Auto-

Unload is not activated, then after completion of 

the exposure a dialog window pops up asking if 

the substrate should be unloaded. Click Yes, if 

you want the system to unload the substrate or 

No if the substrate should stay loaded on the 

chuck e. g., to expose the next layer.   
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 FIELD ALIGNMENT PROCEDURE (OPTIONAL) 

Field alignment is offered by a checkbox in the Alignment: Exposure panel. To 

execute a field alignment, activate the Field Alignment checkbox. If there is an array of 

3 x 3 fields on each layer, for example to produce microchips, each field is aligned with 

the field on the previous layer prior to exposing each field several times. The coordinate 

systems of the design in the first layer is identical to the one of the design in the second 

layer.  

 

Follow the steps to prepare and execute a field alignment:  

 Prepare a first layer with at least two alignment marks outside the array of fields as 

well as one alignment mark within each field.  

Note: It is also possible to execute the global alignment in the first layer only with the 

field alignment marks since only the angle rotation is being measured which 

requires at least two marks. However, it is recommended to put two alignment 

marks outside the array of fields since it is crucial that the two marks are 

positioned as far as possible from each other.  

 Expose and process the substrate.  

 Now, the first layer is created.  

 Load the substrate again and select a design for the second layer. Choose 

Standard as exposure mode.  

 In the Alignment panel execute an alignment as usual (global alignment) based on 

the alignment marks outside the fields to determine the global alignment angle. 

 Then activate the checkbox Field Alignment. A table opens. Here, the information 

of the cross in each field in layer one must be entered so that the system is able to 

align both layers with very high accuracy.  

 Layer 1 

 
Layer 2 

+ Alignment mark 

Figure 18: Alignment marks exposed on first layer and overlay of second layer 
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 Enter the required information for finding and aligning the crosses of layer one to 

layer two.  

• Position of Cross Enter the positions of the crosses exposed in 
layer one. The position of each of these crosses 
refers to the coordinate system of the design in 
the same field.  

• Number of Fields Enter the number of fields in x and in y direction.  

• Step Size X/Y Enter the distance of the fields exposed in layer 
one to each other. 

• Measure Cross Number Enter the cross of the field the system should 
start the alignment procedure with. 

 

 After having filled all fields with the required information the system is ready to 

execute cross alignment again. Start with bringing the cross entered at Measure 

Cross Number into the center of the camera image field. This ensures the 

correspondence of the cross in the table to the cross in der camera image.  

 Click Measure. An automatic cross alignment is executed. To restart the cross-

finding procedure, click Restart and repeat the procedure.  

1/1   2/1  3/1 

 

1/2   2/2  3/2 

 

1/3   2/3  3/3 

Figure 19: Order of field counting 
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Note: All the crosses are detected automatically in one procedure. It is not necessary 

to start a measurement procedure for each individual cross.  

 Before starting the exposure, it is possible to activate and deactivate individual 

fields. If one or more of the fields should be left out from exposure, click on the field 

in the substrate representation.  

 

 To execute the exposure of the second layer, click Start Exposure.  

 The system exposes the second layer. Exposed fields are displayed in green. 

Fields in red indicate that no exposure was executed in these fields. At the end of 

the procedure, result information is displayed as well as the cause of failures.  

  

 
activated 

 
 

 
deactivated 

matiask
Highlight
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 SERIES EXPOSURE PROCEDURE 

After having loaded the substrate and the design, the substrate is ready to be exposed. 

You are in the Series panel of the Series mode. 

In this panel, several values have to be set for series exposure. Find the explanation of 

the panel elements below: 

Lightsource: Check the laser wavelength and if necessary 

change it.  

Mode: Three different selections are possible: Dose, Defoc 

or Dose and Defoc. 

Number of fields: Use the spin button to select the number 

of fields to be exposed 

In the Dose Series table, you set the parameters for the 

series with varying energy values.  

In the Defoc Series table, you set the parameters for 

exposing the design with varying defocus values. The 

defocus allows fine tuning of the exposure focus. 

In the bottom table, the Step size in x and y direction is 

determined. Here you can also set the number of rows for 

Dose or Defoc exposure.  

For information about Auto-Unload see 6.10 Unload 

substrate. 



 MLA150 
6 Job setup  

 

 

 
User Guide  75 

It is possible to write the parameters dose and defoc in plain 

text below the design on the wafer. If the Expose Labeling 

checkbox is activated, an additional exposure is executed to 

write the parameters below the exposed field. This does not 

increase the exposure time. Keep in mind, that the step size 

has to be increased so that the label fits below each field. The 

Step Size field gets highlighted in orange in case the step size 

is too low. With labeling exposure, the Total Range increases. 

When choosing Dose Series only, the Defoc value is fixed. The Dose value is fixed 

when Defoc Series is active.  

The substrate visualization shows the arrangement of the fields according to the values 

set in the Series panel. This feature facilitates the preparation of series exposures. The 

horizontal fields are for defocus series and the vertical fields represent the dose fields 

(see below example left). In Dose or Defoc Series the number of rows can be adjusted 

to maximize the area the fields can be arranged (right example). If the fields overlap, the 

step size has to be changed to a higher value. If the field arrangement exceeds the 

substrate surface size, the number of fields must be reduced.  

 

 Select from the options in the Mode dropdown list: Dose, Defoc or Dose and 

Defoc. 

 Set the values required for the selected mode.  

 If desired, activate Auto-Unload (see 6.10 Unload substrate).  

 Click Start Exposure. 

Dose only  
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 The machine is exposing the design. The first field is 

always converted online, the other fields use the 

same data offline. If Auto-Unload is not activated, 

then after completion of the exposure a dialog window 

pops up asking if the substrate should be unloaded. 

Click Yes, if you want the system to unload the 

substrate or No if the substrate should stay loaded on the chuck e. g., to expose 

the next layer.  
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 DRAW MODE EXPOSURE PROCEDURE 

After creation and submission of the image, you are still in the Draw Mode panel to start 

the exposure. 

In the Draw Mode panel 

 Set the Dose value by entering the value into the text field. 

 Set the Defoc by selecting the value with the spin buttons [range -10 to 10] 

(extended defocus range [-25 to 25] depends on resist templateFehler! 

Verweisquelle konnte nicht gefunden werden.). The defocus allows for fine 

tuning of the exposure focus. 

 Optional: Activate Auto-Unload. The system executes the unloading procedure 

automatically (see 6.10 Unload substrate). 

 Click Start Exposure. 

 In the Progress Info section the table changes to a list displaying the Draw Mode 

procedures that are already executed. The most recent one is listed at the top of 

the list. You also find the information about the type of draw mode image and the 

coordinates of the center of the image.  

  



MLA150  
6 Job setup 

 

 

 
78 User Guide 

6.10 Unload substrate 

 USING THE AUTO-UNLOAD FUNCTION 

For unloading the substrate, the system provides a function called Auto-Unload. This 

function is selectable by activating a checkbox. Read more in the information below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Auto-Unload checkbox 

The Auto-Unload function automatically brings the stage into unloading position directly 

after exposure completion. Activate the Auto-Unload function by clicking into the 

checkbox before starting the exposure procedure. Above, possible locations of the 

checkbox are shown. Depending on the exposure mode, the checkbox can be located 

below the info box or below the parameter setup frames. After the unloading procedure 

is finished, the wizard directly leads you back to the Setup Job Panel where you can 

start a new job with New Job. You can take the substrate from the chuck or leave it 

there for exposing a further layer. 

Unload Substrate button 

The wizard also features an Unload Substrate button that is available in the Setup Job 

panel.  

  

Figure 20: Possible locations of the auto-unload checkbox 
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 REMOVING THE SUBSTRATE FROM THE CHUCK 

To remove the substrate from the chuck, follow the steps below: 

  Push the window button and release it again. The window opens.  

 At the operator panel switch off the vacuum.  

 

 Carefully take the substrate off the chuck and stow it in an opaque box 

impermeable to light. 

 Close the window by pushing and releasing the button. If required, click OK in the 

Exposure Wizard to close the unloading dialog. 

 

  

 Resist coated substrates get useless when 
exposed to white light! 
Non-safe light may only be switched on when all 
substrates are stored in boxes impermeable to light. 
Otherwise, the substrates become useless. 

Note: This user guide does not give instructions on substrate processing.  
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The MLA offers further elements beside the main menu that facilitate handling the 

exposure and alignment processes. Select Tools→Control Panel from the menu bar to 

open the panel. The item Control Panel is not available until a substrate has been 

loaded.  

7.1 Control Panel 

The Control Panel is a utility that provides navigation functions as well as other 

necessary control functions.  

In the Camera Control frame, the button for selecting the available cameras are 

arranged. A selection is done by clicking the button for the camera of choice. The 

camera is then activated. The information below about the field of view of the different 

cameras helps to select a camera that is appropriate for the current application. Using 

the High Res or Low Res camera for alignment is recommended whereas the 

Overview camera can only be useful for alignment procedures with coarse structures.  

  

Top Surface  Back Surface 
 

 

 
 Field of view   Field of view 

Low Res 640 µm x 480   Backside 640 µm x 480 µm 

High Res 190 µm x 140 µm    

Overview* 12 mm x 9 mm    

*Overview cannot access the entire surface 
of the substrate due to mechanical limits. 

 

 

Below these you find one Focus slider for setting the camera focus and a Brightness 

slider for setting the brightness of the camera image. In Alignment Mode, for very thick 

resists the focus can be switched to larger camera defocus with a wider defocus range 

by selecting Tools→Large Camera Defoc from the menu bar. The slider bar is now 

named Range. Moving the slider changes the focus position in a wider range.  
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Click on the slider and keep the mouse button held down while moving it to the desired 

value on the slider bar. Alternatively, click on the slider bar and use the cursor keys for 

moving the slider along the bar. The tick marks on the focus slider bar are for your 

orientation within the range from −10 to +10 so the center tick mark sets the focus to 0. 

A positive number brings the camera focus closer to the substrate.  

The Stage Control frame provides arrow buttons for moving on the substrate surface. 

Every click is one move. They are also used for fine positioning.  

To determine the kind of movement, you can switch between continuous movement and 

stepwise movement by clicking into the corresponding field. In continuous mode, 

change the driving speed [µm/s] either by using the slider or by clicking into the value 

field and entering the speed manually. Alternatively, click into the slider field and use the 

arrow keys for setting the speed. In step mode, enter the step size [µm] for X and Y 

direction. The arrow buttons for navigation on the substrate surface change their 

appearance according to the selected mode. This contributes to a fast identification of 

the mode currently selected. 

The Set Zero button allows to set an arbitrary point as zero coordinates (not available in 

Alignment Mode). With Move To Zero it is possible to go to the zero point set before. 

Clicking Substrate Center allows to move the field of view to the center of the 

substrate. To stop any stage movement, make use of the Stop button. 
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7.2 Optimizing alignment and exposure results 

 UNSATISFYING ALIGNMENT MEASUREMENTS 

Sometimes the measurements during the alignment process might be unsatisfying due 

to bad contrast caused by uneven surface conditions or low reflectivity of the substrate. 

This chapter gives advice how to improve the measurement results during the alignment 

process.  

 

Repeat the measurement 

Clicking Re-Measure repeats the measurement procedure which can lead to new 

results. The Measure button turns into the Re-Measure button after the first 

measurement procedure for one coordinate point.  

 

Change the size of the detection area 

For the finding cross function to work properly it is important that the alignment cross 

fills the entire camera window. If this is not the case, click ResizeDetectionArea. Inside 

the camera window, a rectangle appears showing the new detection area. To enlarge 

the detection area, click the right bottom corner of the rectangle without releasing the 

mouse button and drag the corner to the desired size while holding down the mouse 

button. To maximize the detection area again, click MaximizeDetectionArea. 

 

Change settings in the Control Panel 

• Adjust the values for Focus or Brightness to make the finding cross function work 

more efficiently.  

• Select Tools→ Large Camera Defoc from the menu bar to extend the camera 

defocus range. The Focus slider bar got renamed into Range (see 7.1 Control 

Panel).  

• Choose a different camera, to get a better view on the substrate. 

Switch to Manual Mode 

For every single alignment cross it is possible to switch between the two modes for the 

alignment procedure. ManualAlignment is the manual mode for cross detection and is 

provided for exceptional cases in which the automatic detection might not work properly. 

Switch to ManualAlignment and follow the instructions given in 6.8 Setup Overlay 

Alignment.  
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 UNSATISFYING EXPOSURE RESULTS 

Sometimes exposure results can be unsatisfying for the needs of distinctive 

applications. The MLA150 offers a way of optimizing the exposure outcomes. It is 

possible to adjust the Defoc value or the Dose value. The following section gives details 

about how to work with these two values in order to improve exposure results.  

The Exposure Wizard offers a series exposure mode (6.8.3 Series Exposure 

Procedure). This utility can be used to optimize exposure results by adjusting the 

defocus value (Defoc) and/or the energy value (Dose). In order to find the best ratio 

between these two parameters a series of exposures with different values can be 

executed.  

 

For more information see the relevant chapter on series exposures.  
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 SET ALIGNMENT ANGLE  

It is possible to set an angle manually with only one alignment mark. This might be 

required if the substrate is too small for more than one alignment mark.  

In the Cross Measurement frame in the Alignment panel click Set Angle.  

 In the camera window, you see a green crosshair. Drag the crosshair to the 

measurement area.  

 Now you see blue coordinate axes that can be moved or rotated. 

To move the axes pixelwise, use the arrow keys.  

To rotate the axes by 1 mRad, use Ctrl+ up/down arrow keys.  

To rotate the axes by 0.1 mRad, use alt+ up/down arrow keys.  

It is also possible to just enter the required angle manually into the 

Angle (mRad) field in the Cross Measurement frame. 

 To submit the angle, click the green tick mark in the upper right corner of the 

camera image.  

 The angle is now calculated and can be used for exposures. The rotation angle is 

shown in the Angle (mRad) field. It is possible to select or deselect the angle for 

individual exposures.   

 i 
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 ADJUST BEAM OFFSET 

(see Advanced functions for Staff user group) 

7.3 Back side alignment  

The following section informs about the back side alignment (BSA) preparation and 

exposure procedure.  

 OVERVIEW OF BSA MARKER ZONES  

The MLA150 comes with a multi-purpose chuck ready to expose both large and small 

substrates.  

For BSA, the chuck provides four designated openings. Markers located in these areas 

are detected by the BSA camera system and used for alignment. 

Each opening is 10 mm wide and 46 mm or 76 mm long. The first edge is located 

12 mm or 14.5 mm from the center of the chuck. The BSA markers can be positioned 

anywhere in this area.  

Figure 21: Back side alignment field of view  
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For easy handling and good resolution, Heidelberg Instruments recommends to position 

the markers on the main axis and about 10 mm from the edge of the wafer. Proposal for 

marker: cross of size 300 µm x 300 µm, Linewidth 20 µm. 

Proposal for marker positions (x/y): 

 

 
Figure 22: BSA marker zones overview  

Wafer 
size 

Marker 1 [mm] Marker 2 [mm] Marker 3 [mm] Marker 4 [mm] 

2 inch +20 / 0 -20 / 0 0 / +20 0 / -20 

3 inch +28 / 0 -28 / 0 0 / +28 0 / -28 

4 inch +40 / 0 -40 / 0 0 / +40 0 / -40 

5 inch +44 / 0 -44 / 0 0 / +44 0 / -44 
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 BSA EXPOSURE PREPARATION  

Back side alignment is mainly done in two steps. Follow the instructions on the BSA 

exposure steps 

Step 1:  

 Expose the pattern on side A with the BSA markers. 

 Position your markers inside the BSA marker zones. The 

recommended cross linewidth is 20 µm. 

 Prepare a strategy to find the markers during alignment: 

▪ a larger cross is easier to find 

▪ add small marks for orientation  

 When using the mirror function during design import, remember 

to click update to all layers. 

Step 2: 

 After processing of side A, position wafer on chuck with side B on top 

 Remove the inlets of the required BSA holes in the chuck. 

 Define your default marker positions in the MLA150 menu. Select Backside 

Camera for this measurement. 

 Execute alignment exposure as usual. 

The coordinate system of the MLA does not change during back side alignment. 

Reference is always the top of the wafer. This means: 

The x-coordinate changes prefix on the back side of the wafer. A marker that was 

written to position +x is now at position –x. When you use the control panel for 

movements, the camera picture will move to the left when you click the "to the right" 

button. 

Side A on top Side B on top 

Figure 23: Orientation on wafer for BSA 
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There are three user log-in types available. Standard, Staff and Service: 

Standard is the default user type when opening the menu. No password is required, 

and the user can set up and execute exposure procedures.  

Staff requires the entering of a password. This user type has the permission to create 

resist templates, job templates, substrate templates and edit a few settings.  

Service user type is for HIMT service staff only.  

This subchapter is about wizard functions that are only available and editable for 

members of the Staff user group.  

8.1 Staff: Backup settings 

The Staff user type can back up the system files. Select Tools→Backup from the menu 

bar. 

 

Note: We recommend copying the backup files from the User PC to an external 
storage media to prevent data loss in the unlikely case of a total failure of the 
User PC. 

• Changing the directory for saving the backup files 
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• Selecting and deselecting items to be saved. The preset items are divided into two 

parts: Basic and Extended. Extended presets require high memory capacity. 

Basic 

Backup Menu Saves the MLA150 Menu software, including 
binaries and configuration files 

Backup Sharkvision Saves files of the camera software including binaries 
and configuration files. 

Backup SSH Saves the user credentials the menu uses to 
communicate with the Linux in the VirtualBox. 

Backup Virtualbox Save some configuration files of the VirtualBox 

Backup Conversion. Saves the conversion software binaries of Linux, 
including binaries and configuration files 

Backup SPiiPlus. Saves the motion controller configuration and 
program buffers 

Backup Light Source Saves laser specific configuration data. 

Backup Stepper Motors Saves the current positions of all stepper motors. 

Backup Autofocus Board  Saves some configuration files of the Autofocus 
Card. 

 
Extended 

Backup Log Files Save all log files created by the MLA150 software, 
including Common Log and Job Exposure Logs 

Backup Designs&Labels Saves design files located in C:\HIMT\Designs. 
Note: May require a large amount of disk space, 
depending on the design size.  

 

8.2 Staff: Laser measurement 

Staff users can measure the laser power to compare it with the value measured during 

the most recent laser calibration procedure.  

 Select Tools→Laser Measurement from the menu bar. A Laser Measurement 

panel opens.  

Prerequisite: Before starting the measurement procedure complete the following 
actions: 

• switch off the vacuum 
 
 

• make sure that the stage is empty 
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 In the Laser Measurement panel select the wave length of the Light Source from 

the drop-down list. 

 Select the number of Measurements as well as the Interval between the 

measurements. It is common to set more than one measurement in order to 

calculate the average value. 

 Click Continue. The system prepares for measurement start.  

 Check the settings and click Measure.  

 The system executes the measurement. The results of the individual measurement 

can be viewed in a list next to the yellow info box. The average results are shown 

in the Results frame of the Laser Measurement panel. 
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 To finish the action, click Finish. To repeat the measurement click Restart and 

start a new measurement.  
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8.3 Staff: Setting up substrate templates 

For users of the Staff group it is possible to set up substrate templates to be used for 

exposure procedures.  

In the Setup Job panel, double-click into the field of the Substrate Template column.  

 The Load Substrate panel opens where you select the substrate for the exposure 

from. 

 

 STAFF: BASIC FUNCTIONS OF THE LOAD SUBSTRATE PANEL 
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 To set up a new substrate, click New in the Edit frame.  

 Fill in the fields in the table. 

 Save the substrate template.  

 A new template is set up that can be used by any user group now. 

 Start a loading procedure and select the new template in the Substrate frame.  

 Load the substrate.  

 During the loading procedure, the system measures the size of the substrate. After 

the procedure is finished, a dialog box informs about the size detected and the 

possible deviation to the size set in the table.  

Characteristics frame 

Name Enter a name for the substrate template.  
 

Shape Select if it is a Wafer or a rectangular substrate.  
 

Small There are three categories of size: small (5-9 mm), standard (10-180 
mm) and Extended (181-230 mm). The category is set automatically 
when the size of the substrate is entered the respective fields.  
 

Size X Enter the size in X direction.  
 

Size Y Enter the size in Y direction. 
 

Diameter Enter the diameter of the wafer.  
 

Thickness Enter a value for the height of the wafer. 
  

Detection 
Offset 

Due to a machine offset the size of the substrate entered might differ 
from the size measured by the system during the loading process.  
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Decide if you want to continue or not. If you decide to stop the procedure because of the 

deviation, go back to the Load Substrate panel and adjust the detection offset (see 

next subchapter). 

Note: It is possible to continue with the deviation but keep the deviation in mind.  
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 STAFF: ADVANCED FUNCTIONS OF THE LOAD SUBSTRATE 

PANEL 

Note: All of these options, except the Autofocus Mode, demand a high level of 

knowledge and experience. Before using one or all these functions it is 

recommended to contact the local Heidelberg Instruments service office for 

discussing the options with respect to the current application.  

 

Autofocus Mode This option is for selecting the autofocus mode from the drop-
down list. Here, two options are available: optical and 
pneumatic.  
 

Check with 
Overview Camera 

Activate this checkbox to check the substrate with the 
overview camera before focusing (same procedure as loading 
small substrates).  

Skip Find Plate 
Center 

 Increased risk of nozzle crash 

Without executing the find plate center 
procedure a stable focus throughout the 
entire surface cannot be guaranteed which 
increases the risk of a nozzle crash.   

 
When activating this checkbox, the find plate center 
procedure is skipped. Activating this option is not 
recommended due to the risk of nozzle crashing and should 
only be considered for special applications after having 
contacted Heidelberg Instruments service office.  

Focus Offset X/Y 
[mm] 

 Increased risk of nozzle crash 

When using the focus offset function keep 
in mind that the risk of nozzle crash is 
increased. Check the offset twice before 
execution.    

 
An offset for focusing can be set here in x- and y-direction.  

Focus Offset Z 
[mm] 

 Increased risk of nozzle crash 

When using the focus offset function keep 
in mind that the risk of nozzle crash is 
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8.4 Staff: Adjusting Detection Offset 

Due to a possible machine offset, the size measured by the system may differ from the 

size given by the manufacturer. If the measurement result during the loading procedure 

shows such a deviation via a message box, it is possible to adjust the detection offset. 

Once adjusted, the offset is saved in the substrate template and valid for the jobs in 

which the template is used.  

 Note down or keep in mind the values given in the issued message that informs 

about the deviation. 

 In the Load Substrate panel, go to the Detection Offset field (see previous 

subchapter) and exchange the value to the deviation given by the measurement.   

Example:  
Size by manufacturer: X= 125.5, Y=125.5 
Size measured by the system: X= 127.8, Y=127.8 
Detection Offset: -2.3 mm 
 

 The system works with the offset, when loading this template. The template can be 

used by all user groups.  

  

increased. Check the offset twice before 
execution.    

 
An offset in z-direction can be set here. This option is 
intended for special applications and should only be used 
after consulting Heidelberg Instruments Service department. 

Max. Velocity 
[mm/s] 

The travel velocity of the stage can be reduced here. Some 
applications might demand lower travel velocities.  
 

Regular Use AF 
Air Pressure 

Some applications demand a switch-off of the air pressure in 
the nozzle. To switch off the air pressure, uncheck the 
checkbox.  
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8.5 Staff: Functions of the Load Resist panel 

For members of the Staff login, it is possible to set up new resists or change existing 

ones. 

In the Layer frame of the Setup Job panel the Resist column is optional for usual 

exposures. By clicking into the value field, the system forwards the user to the Load 

Resist panel in which resists can be setup, changed and saved.  

On the left side, parameters are grouped in frames. On the right side of the panel, a 

button bar in the top and a list of existing resists below are available (more information 

about functions in the loading panel in 4.5 Loading panels).  

The following parameters are grouped in the frames on the left:  

Characteristics frame 

Name Enter a name for the new resist 

Resist Enter the type of resist in use. 

Thickness Enter the thickness of the resist. 

Wavelength Select if the resist template is appropriate for both laser types 
available or just for one. 

Dose Enter the dose to be exposed with.  

  

Grayscale Optimization 

(see section for resists with optimized grayscale exposure) 
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 STAFF: SETTING UP NEW RESIST TEMPLATES 

 In the Edit frame, click New to set up a new resist template name it. 

 Enter the dose and other information into the table in the Characteristics frame. 

Note: To find the appropriate total dose it is recommended to execute a series 

exposure beforehand! 

 If it is no resist for exposing grayscale designs, leave out this frame and uncheck 

the checkbox if required. For grayscale resists, refer to the respective section.  

 In the Exposure Parameters frame set the Speed Factor if required and select the 

Defoc Range (Large or Standard).  

 If all parameters are set, click Save to save the resist.  

 The resist template is now listed and can be loaded by standard users for the 

exposure job. 

 STAFF: SETTING UP RESIST TEMPLATES FOR GRAYSCALE 

OPTIMIZATION (OPTIONAL) 

The system supports grayscale exposures with design of the formats BMP or Grayscale 

DXF. Loading the design is the same procedure as in the First Exposure panel for 

binary designs, unless grayscale dose optimization is required for a satisfactory 

exposure result. 

For grayscale exposures it is possible to change and save the dose values for the 

individual gray values for future exposures. This is done in the Load Resist panel. The 

information is saved in the resist templates.  

 

Exposure Parameters 

Speedup Factor At Speedup Factor higher than 1, the stage moves faster. This 
saves exposure time when using high doses but reduces the 
exposure quality. If exposure quality is crucial, leave the factor 
at 1. 

Defoc Range Choose between Standard and Extended (see 8.5.3 Staff: 
Exposing with extended defocus range). 

Focus depth Function for increasing the focus depth with the purpose of 
gaining steeper edges (see 8.5.4 Staff: Focusing with 
increased focus depth). 

 

Process Parameters 

Enter the information for processing. It might be helpful to the users.  
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 In the Edit frame, click New to set up a new resist template for grayscale 

optimization and name it. 

 Enter the dose and other information into the table in the Characteristics frame. 

Note: To find the appropriate total dose it is recommended to execute a series 

exposure beforehand! 

 In the Grayscale Optimization frame, activate the checkbox Set individual 

Doses for each Bitlayer. 

 A table opens showing the gray value bits in the top row. Here, it is possible to 

assign new dose values to the grayscale value. 

 Distribute the dose to the individual grayscale values by changing the values in the 

Dose row or by changing the percentage in the %-row.  

 After having distributed the total dose to the grayscale values, save the resist with 

Save. 

 Enter other missing information in the frames, if required.  

 The resist template is now listed and can be loaded by standard users for the 

exposure job 
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 STAFF: EXPOSING WITH EXTENDED DEFOCUS RANGE 

 
This function serves for extending the exposure defocus range and is not be 
confused with the Large Camera Defoc function for extending the camera 
defocus range during alignment (see 7.1). These are two different functions.  

Staff users can set up new resist templates and extend the exposure defocus range 

e. g., for exposing deeper into the resist. The range changes from the standard range 

(10 to 10) to the extended range of -25 to 25. Follow the steps below to set up a resist 

for exposure jobs with an extended defocus range:  

 In the Edit button bar, click New.  

 Enter a name and select the values required in the Characteristics frame.  

 In the Exposure Parameters frame, select Large from the drop-down list.  

 

 To confirm the setup of the new resist template, click Save.  

 The resist template is now listed and can be loaded by standard users for the 

exposure job. 

 

  

Note: These steps are also applicable for just setting up a new resist template 
without extended defocusing values. In this case, select Standard from the 
Defoc Range drop-down list (see 8.5.1 Staff: Setting up new resist 
templates for more information on resist template set up.). 

ii i 
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 STAFF: FOCUSING WITH INCREASED FOCUS DEPTH 

In the Load Resist panel the Exposure Parameters frame contains a function for 

increasing the focus depth with the purpose of gaining steeper edges. The increased 

focus depth is accompanied by a reduction of the resolution and a rise of exposure time.  

 

 Open the drop-down list. 

 From the items, select the focus depth necessary for the application the resist 

template is created for.  

• Standard: focus depth does not differ from the standard depth. 

• Large: focus depth is increased, edges become steeper (the dose is adjusted 

automatically). 

• Extra Large: maximum focus depth, edges become steep (the dose is adjusted 

automatically). 

 Check the parameters and save the settings in the resist template.  

Note: Consider that the exposure time increases to a small extent with larger focus 

depth. 

  

matiask
Highlight
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8.6 Staff: Calibrate beam offset  

Note: This function is for seasonal drifts. In general, these are below 1 µm! When 

observing huge offsets, please double-check your alignment marks and 

positions. When in doubt, contact HIMT service. 

It is possible to re-calibrate the beam offset. This is important for exposures done 

relative to existing structures (overlay) Displacements lead to a systematic shift in the 

overlay. For this reason, determination and calibration of the laser beam is crucial.  

For determination of the offset, two layers are necessary that are brought together by 

overlay alignment. The pattern used for the factory acceptance test to determine 

alignment accuracy is ideal for checking the beam offset. It features a Vernier scale 

from which the user can read off the displacement in both directions (X and Y).  

Note: Use HIMT_BeamOffset1 and HIMT_BeamOffset2 from the designs list.  

Each layer contains one part of the Vernier scale in each axis. One layer contains the 

(fixed) ruler and the other one contains the (sliding) secondary scale.  

 

 

Figure 24: Vernier scale in test pattern 
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Figure 25: FAT test pattern 

 

Execute a beam offset calibration 

 Execute an overlay exposure following the instructions on executing an overlay 

exposure. 

 After having exposed the two layers, use the Inspection mode to determine the 

offset. In the Setup Job panel choose Inspection from the Exposure Mode drop-

down list. 
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 Click Inspection in the Proceed navigation buttons frame. 

 

 The Inspection Mode panel opens. Here, it is possible to inspect the pattern by 

moving the stage with the substrate visualization or with the Control Panel. 

 

 

 After having read off the offset from the Vernier scale, from the menu bar open 

Tools→ Beam Offset. 

 

  Enter the value into the respective fields Displacement X and Displacement Y. 

The system calculates the absolute beam offset automatically.  
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 Click Save.  

 The determined beam offset is now included into system operations.   

 

8.7 Staff: Setting up Field Alignment templates 

As mentioned above in 6.9 Expose design, field alignments can be executed to ensure 

higher accuracy for special applications.  

Staff user group members are allowed to set up and save templates that can be used 

by Standard users.  

After having entered all information and before starting the exposure, it is possible to 

save the content of the table by clicking Save. The corresponding folder in the HIMT 

directory opens. Save the file there. 

 

Look up the log file for Field Alignment Exposures 

Go to HIMT/LogFiles/Exposure Log 
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In the Exposure Log folder is a list with job files. Open the file of your choice and scroll 

to the end in the document. There is a section containing a summary of parameters of 

the Field Alignment executed in the job.  
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8.8 Staff: Setting up alignment cross templates 

For staff users it is possible to setup templates for alignment settings. Follow the steps 

below to setup templates to be used for alignment procedures:  

When setting up a layer for exposure in the Setup Job panel, alignment settings can be 

made in the Layer frame. 

 In the Layer frame double-click into the Alignment Settings field.  

 

 The Load Alignment Settings panel opens, where Standard users select an 

existing alignment template for exposure.  

 Staff users can setup and save templates in the same panel, but in the left part.  

 

 Click New in the Edit button bar. The table with the cross positions is editable now. 

In the header cell enter a name for the template.  

 From the drop-down list, select if topside or back side alignment is made using this 

template.  

 Fill the table cells with coordinates of the cross positions. At least one position must 

be given.  

 In the Camera for Alignment frame, select the camera to be used for finding the 

alignment crosses. Per default the Low Res camera is selected. 
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 In the Alignment Correction Options frame, select if Rotation, Scaling or 

Shearing should be applied. Activate the corresponding checkboxes: 

▪ Rotation [mRad]: Is selected per default. The system includes the rotation of the 

substrate. Do only deactivate this option if absolutely necessary. It is 

recommended to keep the checkbox activated.  

▪ Scaling X/Y: The system compares the distance measured during alignment with 

the distance given by the alignment positions (minimum 3 positions). From the 

deviation a scaling factor results. Based on this, the alignment design is shrunk 

or stretched in order to match the previous layer.  

▪ Shearing [mRad]: The system compensates small distortions such as a 

rectangle that appears more like a parallelogram.  

 Check the data entered and click Save. The template is now added to the list and 

can be loaded by all user groups.  
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This chapter contains some notes on daily maintenance by the operator as well as 

some troubleshooting for the most common problems. For more in-depth maintenance 

and troubleshooting information, refer to the related document Maintenance Guide.  

9.1 Operator maintenance 

MLA systems require some minimal operator maintenance that does not involve 

opening any covers or protective panels and can be done by any trained operator. 

These tasks are described below. 

SYSTEM CHECKS 

Before operation the following routine maintenance should be performed: 

 Clean the chuck surface with a dry clean wipe. Never use Acetone! If more 

thorough cleaning is required, use industry-grade ethanol or isopropanol. 

 Verify that the clean room conditions are within the limits given in the Technical 

Data section. 

 Make sure nothing is placed inside the system that obstructs stage movement. 

 Check coolant level and temperature of the stage/laser chiller inside the electronics 

rack. If the level of coolant is below its minimum mark, add clean, demineralized 

water. Do NOT use DI water!  

ENVIRONMENTAL ADJUSTMENT 

 Allow room humidity to come within the specified range before using the MLA150. 

 If temperature is out of range, determine how long this condition has prevailed. 

 Adjust room temperature to within the specified temperature range and allow the 

MLA150 to stabilize.  

 For stabilization of the system, allow an amount of time at least equal to the time 

the temperature was out of range. 

 
During exposure, the most accurate results are obtained 
when the environment remains at a constant temperature 
and humidity. 
To achieve the optimum accuracy, the substrate requires 
thermal stabilization before exposure. This might take some 
time depending on the material, thickness and actual 
temperature. 

 
The set temperature of the flow box should correspond to the 
default room temperature to minimize thermal effects. 
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9.2 Troubleshooting 

This section suggests corrective action for known issues. 

MOUSE DOES NOT MOVE 

▪ Switch on the monitor. In certain systems, the mouse is connected to the 

monitor. If the monitor is switched off or in sleep mode, the mouse is inactive as 

well.  

THE MLA150 DOES NOT EXPOSE 

▪ Verify that the AC power cord is plugged into the wall outlet and that the outlet is 

receiving power. 

▪ Check whether the laser is switched on and running (see if LED is on). 

▪ Verify that the loading window is completely closed. 

▪ Try rebooting the system. 

LINES NOT TO SIZE 

▪ Line thickness problems may have the following causes: 

▪ Poor developing chemicals 

▪ Wrong developing speed 

▪ Wrong resist type or thickness 

▪ Focus or energy setting incorrect 

▪ Out of date resist 

THE MLA150 STOPS ANYTIME DURING THE EXPOSURE 

▪ The MLA150 reached an end switch because the imaging area was set 

incorrectly 

▪ The interferometer head is broken 

▪ The conversion encountered a problem 

SUBSTRATES COME OUT COMPLETELY CLEAR 

▪ Laser might be off. Check laser status at LED. If LED is not illuminated, laser is 

not running.  

BAD ALIGNMENT ACCURACY 
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▪ Check stability of flow box temperature 

▪ Check vacuum quality, make sure no vibrations are transferred via vacuum 

▪ Check stage vibrations 

▪ Check for drift in position measurement with stage standing still in home position 

to find if interferometer laser has to be replaced 

SCRATCH MARKS ON WAFER EDGE 

▪ Edge beads are not removed. Remove edge beads with the appropriate method 

to provide uniform thickness of coating across the wafer.  

CAMERA SOFTWARE DOES NOT RESPOND (HANG-UP) 

▪ Use the small window to close the camera software. Then, in the wizard, use a 

button or perform an action which the camera software is necessary for. A 

message pops up asking if a reconnection should be tried. Click Yes to 

reconnect the system to the camera software. If you click No, the message 

closes and won’t return. It only pops up again, when using the Refresh button in 

the Hardware Info section of the wizard.  

9.3 Error messages 

Camera software  

If the connection to the camera software gets lost, an error message dialog informs 

about it.  

 If a reconnection is required, click Yes. Otherwise click option No. 

 When the reconnection is established, in the wizard use a button or perform an 

action which the camera software is necessary for.  

 Another message pops up to inform about the status of the camera software.  
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9.4 Changing the level of logging 

The scope of logging is set by an HIMT engineer during installation. It can be changed if 

this is required. Only change anything when asked or if you require this for reasons of 

memory space. Leave the Log Service activated at any other time.  

Inform our service staff before making any changes.  

 

9.5 TeamViewer software 

Not

10 On the desktop, you find the icon for the TeamViewer Software. This software 

enables the service engineer to access the system via remote connection. It might be 

possible that the service person asks for the system's access data.  

 Start TeamViewer QS by clicking on the shortcut icon on the desktop.  

 Pass on the access information to the service person. Both, ID and password are 

required.  
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